Using DataTrac 3 Software

The DataTrac 3 software (Decagon Devices, Inc., Pullman, WA) allows to collect, manipulate and analyze
data from the Em50 series data loggers (Decagon Devices, Inc. 2013). It is also compatible with the
DataStation, which serves as data collection point for multiple radio transmission enabled data loggers.
Although DataTrac can be used to connect to and configure Em50 series data loggers (in similar ways as
the ECH20 Utility software), its built-in features and functions makes it more suitable for simplifying
viewing and analyzing of data. In the following sections, this module describes in detail the various

features and functions of DataTrac 3.

1. DataTrac 3 features
The main screen/display of the DataTrac 3 program is given in Figure 1. It is composed of various menus,
toolbar, device directory, chart/table area and status bar. These important features of DataTrac 3 are

explained below.

The Device Status Area: displays information about the device currently selected in the device directory,
and connected to in DataTrac 3. For data loggers (when connected), it will display the logger’s name,
logger type, logger firmware and battery status. When DataTrac 3 is connected to a radio logger via the

RM-1, the status also shows the radio signal strength for the connection.

The Toolbar: is located at the top of the screen. The various tools are used to interface with the logger.
These controls which make up the toolbar are listed below (Decagon Devices, Inc. 2013).
Connect Via: is used to select a COM port to connect to a logger via a Decagon USB cable, RS-
232 serial cable (direct connect) or a RM-1 radio modem.
Connect/Disconnect button: connects to or disconnects from a device.
Download: downloads data that has been collected by the device since the last download from
that device, i.e. only new data. It performs the same function as the Download > New Data
option under the Connection menu.
Scan: allows to make instantaneous readings of all sensors connected to the logger’s ports.
Report: allows to save a PDF document of the currently selected logger in the Device Directory
that includes logger location, name, notes, current chart view, and summary data below the

chart.
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Chart/Table View: switches between Chart and Table views of downloaded data.

Configure: is used to configure various aspects of a logger.

The Device Directory: (sometimes called the device tree) is where all devices/downloaded node data

will appear. DataTrac 3 uses folders to organize devices. Click on a device to see data from the device or

to configure the device.

The Taskbar: The taskbar, or the device status bar, is located in the bottom left corner of the screen and

displays any DataTrac 3 system messages. When working with DataTrac 3, please wait until the taskbar

says Ready before proceeding.
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Figure 1. The DataTrac 3 main screen.
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2. Working with DataStation

When appropriately configured, the radio enabled Em50R data loggers can transmit data collected to a

DataStation. A DataStation can receive data from multiple Em50R data loggers simultaneously.

However, the logger data from the DataStation still requires configuration and entry into DataTrac 3,

which is handled differently than when connecting to an individual logger. In order for all of this to

happen, the DataStation has to be connected to a computer/laptop and properly configured first. It

needs to have the radio channel and sub channel set before it can collect data from loggers. The section

below details how to connect, configure and download data from DataStation in DataTrac 3 (Decagon

Devices, Inc. 2013).

a.

Connecting to a DataStation

Connect the DataStation to the computer’s Communications port via an RS232 cable.

Open DataTrac and select the appropriate COM port from the "Connect Via" drop-down list, and
click the "Connect" button.

After establishing connection with the DataStation, the DataStation will be added under the
New Devices list in the device directory.

Configuring the DataStation

Select DataStation in the device directory and click on “Configure” on the toolbar or from the
Setup menu in DataTrac 3 to enter Device Setup (Figure 2).

The DataStation name in the “Device Name” box can be changed if desired.

Press the "Set Time" button to synchronize DataStation clock to the time on the computer.

Press the "Erase Data" button to erase any data stored on the DataStation before.

Configure Device Py

= Desice Device Model:  DataStation

Device Mame: D51077

Serial Number: DS1077
Firmwrare D5 1.10

MNotes:

Auto-download

| OK “ Cancel ” Apply

Figure 2. The Device Setup screen.
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— Double click on the radio sub-menu to configure your radio properties (Figure 3). The channel
and sub channel have to be set to the same channel and sub channel as the Em50R’s to collect

data from at this DataStation.

Configure Device &J
[=)-Device Channel: Subchannel: Radio Version:
L | 6 ~| &0 = |5000
[ 0K “ Cancel " Apply l

Figure 3. Channel and subchannel configuration in Device Setup

c. Downloading data from DataStation
The DataStation is a listen only device so there is no need to set the radio mode, which is set when
Em5O0R loggers are configured. Once the loggers are properly configured and collecting data, the data
transmitted to the DataStation can be downloaded into DataTrac using the steps below.

— Connect to the DataStation.

— Once connected, click the "Download" icon.

— When the new data is read in, it will appear in the chart when that particular logger is selected

in the device directory.

Data can also be automatically downloaded from DataStation to DataTrac 3 by checking the “Auto-
download” box in the “Device Setup” window (Figure 2). However, DataTrac 3 must be running and the

DataStation connected to the computer through a COM port for this to work.

When using Em50G data loggers, DataTrac 3 will automatically download data from any Em50G

subscription every time the program is initiated.
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3. Direct connection to data loggers

DataTrac 3 can be used to connect to Em50 series data loggers directly using either a USB or serial cable.

For Em50R data loggers, an RM-1 can also be used to create a virtual cable from the data logger to

computer (this should only be done temporarily since remote connection using the RM-1 drastically

reduces the power efficiency) (Decagon Devices, Inc. 2013).

To connect directly using the Decagon USB or serial cable

Open DataTrac 3.

Connect the Em50 series logger or Em5b data logger to a computer via the Decagon serial cable
or Decagon USB cable. To use Decagon’s USB cable adapter, it is important to have the USB
driver installed on the computer to wuse. The driver can be found at

http://www.decagon.com/support/decagon-usb-cable-adaptor-driver/.

From the drop down menu for the “Connect Via” option on the tool bar, select the appropriate
communication Port. This port will have the port number followed by “Decagon UCA”.

Once you have selected the correct COM port, click on the Connect button on the tool bar.

To connect to an Em50R using RM-1 (Decagon Devices, Inc., 2013):

Connect the RM-1 to your computer with the accompanying RS232 serial cable or USB cable.

In DataTrac3, select which COM port the RM-1 is connected to from the "Connect Via" combo
box, and select "Connect Via RM-1 on...".

Click the "Connect" button on the Toolbar.

If you have not already highlighted a logger in the device directory, DataTrac will ask you which
channel and sub channel you would like to connect on. Enter a value for each, then click "OK".

If you know which logger you want to connect to, select it in the display tree and then click
"Connect". DataTrac 3 will not display the "RM-1 Settings Dialog", because these values are
already set. However, if you try to connect to a non-radio enabled logger, DataTrac 3 will display
an error message. This means that: (a) the device is not a radio logger (Em50R or Em5R), or (b)
the device’s radio is either not connected or not correctly configured (i.e. its radio mode is set to

"Radio Off/ No Radio").
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Make sure you are using a radio logger and that it is correctly configured, then connect again. If the
connection is successful, the radio logger’s information and RSSI data are displayed in the device status

area. DataTrac 3 will also indicate that your logger has not been configured yet.

Downloading data directly from Em50 data loggers
Once direct connection is established, data can be downloaded directly from the Em50/Em5 data
loggers using the step below.

— Select to download “New Data” or “All Data” from the “Download” option in Connections menu.

The “Download” button on the toolbar downloads new data only.

4. Importing data into DataTrac 3
In addition to the two main ways of downloading data into DataTrac 3 described above, data that is
downloaded from Em50 series data loggers using ECH20 utility software in .dxd (DataTrac 3 compatible)
file format can also be directly imported to and analyzed in DataTrac 3. This is done using the “Import
Data File” option under the File menu of DataTrac 3. The steps listed below can be followed.
— In the File menu, select the option “Import Data File” (the keyboard shortcut Ctrl+O can
alternatively be used.

— In the window, browse and select the .dxd file/s to be imported and click open.

5. Visualizing data in Chart view
Once data logger is entered into the DataTrac 3 database using the various data entry ways mentioned
in the previous sections, the data collected can be viewed in a chart format following the steps below.

— Inthe DataTrac 3 device directory, select the logger for which data is going to be viewed.

— If data is in Table view, click on “Chart’ on the toolbar or in View menu (shortcut Ctrl+G) to view

data in chart.

A Chart view for weather station is given in Figure 4. An axis will appear for each type of measurement
being displayed. Using the mouse pointer, any of the x- or y-axes can be moved for ease of viewing. It is
possible to zoom in on a specific area of the chart using the zoom-in (+ sign) tool in the lower right

corner. Specific range of dates can be inserted in the "Chart Period" box at the bottom of the graph to
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visualize data from that period. A Day, Week, Two Weeks, Month, Season, or All Data can be selected in

the "Chart period" drop-down menu for custom views of the data (Decagon Devices, Inc. 2013).

Data is arranged in the “Chart View” such that the current data point is at the right of the screen. For
example, to view data from June 2009 to June 2010, the table would display data from just before the
first and slightly after the last data points in that range. However, when selecting Week view for
example, the chart will place the current date’s data point at the right of the screen and display data
from a week before it to the left. By scrolling over and stopping on a specific data point, the exact date
and associated data can be seen. By double clicking with the left mouse button on a chart data point, an

annotation box will appear that allows describing certain data points (Decagon Devices, Inc. 2013).

A right mouse click on the chart will bring up a menu with the following choices:

Show Table View: opens the Table of the corresponding chart.

Toggle Drag: turns this feature on or off

Toggle Zoom Box: switches between the pointer and the Zoom box function on the mouse

Zoom In: allows mouse clicks to zoom in on a certain location.

Zoom Out: allows mouse clicks to zoom out on a certain location.

Copy Chart to Clipboard: copies displayed chart for pasting in external locations

Export Chart...: allows you to save chart as a picture files (such as BMP).

Toggle Grid: switches grid lines on and off

Clear All Annotations: removes all annotations on a chart and from the database.

Toggle Legend: Switches the legend on and off.

The chart axes were designed to be larger than necessary to allow the user to drag traces on and off of
the screen. For example, if you have a busy chart and want to move a particular trace to make more
space, click on that trace’s chart axis and drag the mouse upward to take the trace off the screen. The
trace will be returned to its starting position if you leave the chart view and return to it. You can also
shrink and expand the axes by double clicking on the axis. To add comments to the chart, double click on
the location where you would like an annotation and enter any comments about the selected time

period that you feel would be helpful.
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Figure 4. Chart view.

6. Visualizing data in Table view

The Table view displays data in a spreadsheet format, with the date and time of each measurement on
the y-axis and the 5 ports on the x-axis (Figure 5). Clicking the check box to the left of each reading will
display an "x" that removes that data point in the Chart view. Rows/columns/cells can be copied and
pasted in other programs such as Microsoft Excel. A right mouse click on the table will bring up the
following choices (Decagon Devices, Inc. 2013):

Show Chart View: switches to the corresponding chart for this table.

Show Processed Data: this is selected by default and shows processed data.

Show Unprocessed Data: converts the data to the raw or unprocessed values.

Show Unprocessed Parts: converts the data to the raw or unprocessed values. For sensors measuring
more than 1 parameter, separate raw/unprocessed values corresponding to each parameter is given.
Copy: copies the selected cells to the clipboard so that it can be pasted into other programs for use in
reports or web pages.

Select Visible: selects the data rows that are visible to the user.

Select All: selects all data.
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Figure 5. Table view.

7. Configuring data loggers
Data loggers that are entered into the DataTrac 3 database for the first time must be configured in order
for the loggers to collect correct data. The “Configure” tool is used to assign the correct sensor in each
port, select charting colors, add user defined calibration coefficients, modify chart axes, and to set target
range among others. Use the steps below to configure data loggers.

— Select data logger name in the device directory.

— Select “Configure” on the toolbar after the data is displayed in the chart/table format. When the

node is selected, chose "Yes” if a dialog box that asks to configure the node appears.

— The “Configuration Device” window will appear (Figure 6).
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Figure 6. The Configure Device screen.
Device
— Under “Device”, “Radio” and “Location” will show information that was entered when the data

logger was configured using ECH20 Utility.

Sensors and Measurements
— Under “Sensors and Measurements”, click on Port 1 to Port 5 and select the corresponding
sensor on the right (Figure 7).

— Sensor label and information such as sensor depth for soil moisture sensors can also be entered.

Configure Device
=-Device s WO 050-5 PAR Pholon Flux [=]

i Radio
= Location Sensor Depth:

[=)-Sensors and Measurements
i R Sensor Label:  QSO-5
Port 2 ECRN-100

Paort 3 EHT

Port 4 Davis Cup

Port 5 LWS

=) Virtual Port

t Daily Light Integral

t Growing Degree Day

- Chart Axis

Relative Humidity (%)
Predpitation (mm)

Wind Speed (m/s)

Leaf Wetness (minutes)
Photosynthectic Photon Flux [
Counts

Growing Degree Day

Daily Light Integral {mol/m>d)
Temperature (°C)

Target Range

B e

Figure 7. Photosynthetically active radiation (PAR) sensor is selected from the drop down list.
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— Click on the + sign in front of the port number. The parameter(s) measured by the sensor

selected will be displayed.

— Click on the parameter name and select the trace color, line width and markers desired on the

right (Figure 8). These selections will be displayed when data is displayed in chart view.

— Click “Apply” to save the changes made.

Configure Device

=l Device
i l-Radio
~Location
= Sensors and Measurements
i E-Port1 EC-5
... Percent Volumetric Water
i E-Port2 EC-5
. [-Port3 EC-5
. [)-Port4 EC5
. [)-Port 5 Flow
- Virtual Port
=) Chart Axis
| -Percent Volumetric Water Con
L volume (US gallons)
Target Range

Chart Contrals

Trace Color ® puple |Z|
e wit | |
Markers None |Z|

Water Content
Approximate Soi Media: |User Defined v
B = 0.00e400 x*+ 0.00e400 x34 0.00e+00 x24 8.50e-04 x4+ -4.81e-01

Note: 8isin terms of Volumetric Water Content (im%/m3)
and xis in terms of raw voltage response of the sensor.

Apply to Matching Sensors

[ ok [ cancel [ appy |

Figure 8. The Configure Device window showing option for entering custom calibration coefficient.

Entering user defined sensor calibrations

— For sensors that need custom calibration (such as soil moisture sensors), select the “User
Defined” option from the “Appropriate Soil Media” drop down menu (Figure 8).

— Enter coefficients of the custom calibration equation made.

— Click on “Apply to Matching Sensors” to apply calibration coefficients to similar sensors within

the node.

—  Click “Apply” to save the changes made.

Chart Axis
— Select each axis under the Chart Axis option (Figure 9).

— In the window on the right, enter the range (minimum and maximum) desired for the parameter

selected.

— Chose axis color.
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— Uncheck the “Draw Axis” to hide the parameter (both axis and data) in chart view.

— Click “Apply” to save changes made.

Configure Device =3
=~ Device o . o
i Radio Moz 0 = M 100 =
i Location
ot Coor: | TS
- Sensors and Measurements E
- Port 1 Q5045 ] Draw Axis
*:' Port 2 ECRN-100
f-Port 3 EHT

+ Port 4 Davis Cup
i) Port 5 LWS
B Virtual Port
{- Daily Light Integral
L. Growing Degree Day
I~ Chart Axis
{. Relative Humidity (%)
- Predipitation (mm)
- Wind Speed (m/s)
- Leaf Wetness (minutes)
- Photosynthectic Phaton Flux [
- Counts
- Growing Degree Day
- Daily Light Integral {moljm?d)
L. Temperature (°C)
-Target Range

o [ oo e

Figure 9. Minimum and maximum values for the parameter relative humidity are set.

Target Range
This can be set for any sensor/parameter.
— Click on “Target Range”.
— Onthe window on the right, click on the green + sign to add the parameter desired.
— From the drop down menu for “Measurement”, select the sensor and parameter for which
target range is desired.
— Enter name, starting and ending date, the lower and upper values desired and select color.

— Click “Apply” to save changes made.
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Figure 10. A target range for a photosynthetically active radiation (PAR) sensor.

Finally, to save all configuration changes made, click “Ok”.

8. Virtual Port

This is one of the most important functions of DataTrac 3 as it enables incorporation of measurement
done by other devices into a data logger and the creation of parameters of physiological importance
from direct sensor measurements. These two functions that are enabled by the “Virtual Port” option in

DataTrac 3 are explained below.

8.1. External measurements
By selecting “External Measurement”, a measurement that is made by a different device can be
incorporated into a given data logger in DataTrac 3. The external measurement will be graphed with
existing data. The steps below can be followed to incorporate external measurement into an existing
data logger.

— Select “Virtual Port” in the Configure Device window at the end of Sensors and Measurements.

— Choose “External Measurement” from the drop down menu on the right (Figure 11).
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— Click on the “Select Measurement...” drop down menu and select the logger
parameter/measurement that is going to be incorporated into an existing data logger.
— Select Create Virtual Measurement.

—  Click “Apply” followed by “Ok” to save changes made.

Configure Device @

[El(ternal Measurement - ]

Select Virtual Measurement Type...
’ -

=5 Sn_ensors and Measurements Growing Tools

+-Port 1 Q50-5 Create Virtual Measuremant
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-Port 3 EHT

- Port 4 Davis Cup

~Port 5 LWS

- Virtual Port

—I- Chart Axis
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Photosynthectic Photon Flux [

Counts

Growing Degree Day

Daily Light Integral (mol/fmz2d)

Temperature {°C)

- Target Range
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s
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Figure 11. The External Measurement option is selected in Virtual Port.

8.2. Growing tools

Growing tools use the data collected from sensors to calculate common variables used by growers.
These variables are then graphed with other measured data. The steps below can be followed to create
growing tools in DataTrac 3.

— Select “Virtual Port” and choose Growing Tool from the dropdown menu on the right.

— In the “Select Derived Product Type...” drop down menu, select the growing tool that is going to
be integrated into the logger. The growing tool selected will be graphed with the other
measurements in the data logger.

— Depending on the growing tool selected, chose the sensor parameter(s) from which the required

growing tool is to come from.
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— Click “Create Virtual Measurement” to add the growing tool to the chart and table.
— For many of these tools, there is a need to also supply additional information for the calculations
to work properly. If prompted, enter any additional information (Figure 12).

— Click “Apply” to save the changes made.
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Figure 12. A Growing Degree Day (GDD) growing tool with base temperature of 15 °C.

The growing tools available in DataTrac 3 include (Decagon Devices, Inc. 2013):

Plant Available Water: uses volumetric water content data and soil type data (input by user) to
estimate plant available water (amount of water above wilting point). These estimates are
calculated by using a modified calculation from Saxton and Rawls (2006).

Pore Water EC: uses the volumetric water content, temperature, and bulk EC to estimate Pore
Water EC using the Hilhorst (2000) equation.

Growing Degree Days: uses a measured temperature reading, a base temperature (input by
user), data logger measurement interval (input by user), and a start date (input by user) to

calculate accumulated growing degree days.
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Reference Evapotranspiration Growing Tool: reference evapotranspiration, or ETO, estimates
the amount of water removed from the soil by a reference crop growing in a well-watered soil
using the environmental measurements air temperature, relative humidity, wind speed, and
total solar radiation. Decagon uses a modified FAO Pemnan-Montieth equation to calculate a
daily evapotranspiration using calculations outlined by Rick Allen (Allen et al.,, 1998) in
Appendices 1 and 2 of REF-ET  for windows manual located at

http://www.kimberly.uidaho.edu/ref-et/. A complete manual detailing the calculations can be

found at the site.

Daily Light Integral: uses measured PAR to calculate an accumulated daily light integral. The
time period resets at midnight daily.

Vapor Pressure Deficit: uses the TEMP/RH sensors to calculate the difference between
saturation vapor pressure and the vapor pressure of the air.

VWC Delta: uses any soil moisture sensor data to calculate the difference in water content
between measurement intervals.

Chill Hours: uses a temperature measurement (from any sensor measuring temperature) to
calculate the amount of time (in hours) that the temperature is below a certain base
temperature.

Groundwater Depth: uses the CTD sensor to calculate depth to groundwater using the equation

"Installation depth"-"Sensor-measured depth" = "Groundwater depth".

9. DataTrac Preferences
The option “DataTrac Preferences” under the Setup menu (or the keyboard shortcut Ctrl+K) allows to
adjust program settings, the way data is displayed on the screen, and select the units DataTrac 3 uses to

display data. These four sections (Figure 13) are described below.

a. General Program
The General Program Options tab allows modifying basic program settings. The screen options are
described as follows (Decagon Devices, Inc., 2013):
Automatic Internet Version Check: enabling this option will have the program check automatically for
updates when the program starts, whenever you are connected to the Internet. When an update is

found, you will be directed to the website where you can download it.
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Automatic Clock Synchronization: By default, DataTrac 3 automatically synchronizes the logger’s date
and time to the time set on the computer. Click to un-check the check box, which will disable this
feature. You can update the date and time manually anytime you are connected by selecting

Connection> Device Tools > Set Time.

DataTrac Preferences IEI

GeneraIPngram| Measurement Units | Communication I Reportl

Automatic Internet Version Chedk
| Chedk for updates to ECH20 DataTrac as program starts,
This option requires your computer to be connected to the internet to successfully check
for updates
Automatic Clock Synchronization
| Keep device's dock synchronized to PC dock

Localization Settings

Display Date,Time: |Use Windows Regional & Language Cptions  ~ |

Select Language: |Eng|ish - |

Paower Noise Filter

Paower Frequency: |60 Hz Power - |

| oK | [ Cancel l

Figure 13. DataTrac Preferences.

Localization Settings: You have control how your logger’s date and time are displayed on the toolbar. By
default, the date and time are formatted using the settings in the Windows Regional & Language
Options control panel. You can modify this to display the date and time in day/month/year format, with
either 12- or 24-hour format. (In non-english localizations the 12-hour option will display in 24-hour
format). You also have control over the language that DataTrac 3. By default, English is the language
selected at installation time. This may be changed at any point going forward. After changing the
language, DataTrac 3 must be restarted before it will switch languages.

Power Noise Filter: The AC or "mains" electrical power we use every day can add a subtle amount of
noise to the logger sensor measurements. The logger’s Power Noise Filter (PNF) is a setting designed to
eliminate this electrical noise that comes from the AC power distribution system. You should set the
value of the PNF to match the frequency of the power cycle where you live. (North America and most of
Asia use 60 Hz, while in most of Europe it is 50 Hz.) This value only needs to be set once. DataTrac will

automatically set the PNF of each new logger it connects to.
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b. Measurement Units
The measurement units tab allows selecting the units the data is displayed with in chart or table view for
a number of parameters (Figure 14). The units available for each parameter can be seen by clicking on

the down ward arrow.

DataTrac Preferences IEI
General Program |; M surementLln|ts| Communication I Reportl
Water Content % YWC (Percent WWC) -
Water Potential [kPa (kilopascal) v]
Humidity | % RH (Percent RH) -
Drainage [mm (milimeters) V]
Cumulative Drainage [rnrn (millimeters) v]
Water Level [mm (millimeters) v]
Precipitation [mm (milimeters) V]

Electrical Conductivity [Bulk mSjcm (millisiemens per centimeter) vl

Volume ’Gallons [us) v]

Wind Speed [m!s (meters per second) v]

Leaf Wetness [minutes (450 thres) vl

Temperature l“C (Celsius) v]
’ OK ] [ Cancel l

Figure 14. Measurement Units.

¢. Communication
The Communication tab of the Preferences menu allows controlling how DataTrac 3 connects to and
communicates with the Decagon devices. The screen options are described below.
Device Commands Retries: If you are experiencing unreliable communication with a logger, set the
number of Direct Connect Retries - the number of times the computer will automatically attempt to
reconnect to a logger - from 3 to 10 times. For a direct connection, no more than 3 tries should be
necessary. For a radio connection, however, you can have Radio Connect Retries from 5 to 12 times.
Maximum Baud Rate for Direct Connection: Set a baud rate lower than the default 115,200 baud if you
consistently experience a noisy serial connection.
Decagon Data Services: DataTrac 3 offer the ability to automatically download new data from specific
devices. Decagon Data Services will download directly from configured DataStations and Em50G
Subscriptions. The rate at which this feature runs is set from the Communication tab in the DataTrac
Preferences window. It may be disabled or at intervals of increasing length from 1 hour with an upper

limit of 24 hours.
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d. Report
The Report tab of the Preferences menu allows adding a custom logo to PDF reports generated by
datatrac.
Logo Path: This is the location of the report logo image, with the "Browse" button you may browse
through your computer files and select an image to use. In order to use the report logo you must check
the "Display logo in report" box. The logo should be 100 pixels by 100 pixels, and should be a PNG, GIF,

or JPG formatted image.

10. Exporting data

DataTrac gives two easy ways to backup and transfer data files or complete databases:

a. File - Export - Transfer Set: creates a .dzd file for a specific logger, which saves all the
configurations contained in that transfer set. This file can be re-imported into DataTrac using the
“Import Data File” option in the File menu.

b. File - Archival Tools - Backup Databases: creates an .adb file for backing up an entire database.
The “Restore Backup” option under “Archival Tools” in the File menu can be used to restore the saved

database.

11. Updating DataTrac 3 from the Web

Decagon publishes updates to DataTrac 3 on the web. The update installer replaces the old version of
DataTrac 3 with the new release, while retaining all data and settings from the old version. When the
DataTrac 3 computer is connected to the Internet, the Decagon Version Check web engine can be used
to check for updates. Select “Check for Software Updates” from the Help menu. Information about the

currently installed version of DataTrac 3 can be seen by selecting About DataTrac 3 from the Help menu.
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